Matching SCE Trainer Packages for these Learn-/Training Document
- SIMATIC S7-1200 AC/DC/RELAY (set of 6) "TIA Portal"
  Order no.: 6ES7214-1BE30-4AB3
- SIMATIC S7-1200 DC/DC/DC (set of 6) "TIA Portal"
  Order no.: 6ES7214-1AE30-4AB3
- Upgrade SIMATIC STEP 7 BASIC V14 SP1 (for S7-1200) (set of 6) "TIA Portal"
  Order no.: 6ES7822-0AA04-4YE5

Note that these trainer packages are replaced with successor packages when necessary. An overview of the currently available SCE packages is available at: siemens.com/sce/tp

Continued training
For regional Siemens SCE continued training, contact your regional SCE contact siemens.com/sce/contact

Additional information regarding SCE
siemens.com/sce

Information regarding use
The SCE Learn-/Training Document for the integrated automation solution Totally Integrated Automation (TIA) was prepared for the program "Siemens Automation Cooperates with Education (SCE)" specifically for training purposes for public educational facilities and R&D institutions. Siemens AG does not guarantee the contents.

This document is to be used only for initial training on Siemens products/systems, which means it can be copied in whole or part and given to those being trained for use within the scope of their training. Circulation or copying this Learn-/Training Document and sharing its content is permitted within public training and advanced training facilities for training purposes.

Exceptions require written consent from the Siemens AG contact person: Roland Scheuerer roland.scheuerer@siemens.com.

Offenders will be held liable. All rights including translation are reserved, particularly if a patent is granted or a utility model or design is registered.

Use for industrial customer courses is explicitly not permitted. We do not consent to commercial use of the Learn-/Training Document.

We wish to thank the TU Dresden, particularly Prof. Dr.-Ing. Leon Urban and the Michael Dziallas Engineering Corporation and all other involved persons for their support during the preparation of this Learn-/Training Document.
# Table of contents

1. Goal ................................................................................................................................................. 4  
2. Prerequisite ...................................................................................................................................... 4  
3. Required hardware and software ...................................................................................................... 5  
4. Theory ............................................................................................................................................. 6  
   4.1 Fault diagnostics and hardware faults ....................................................................................... 6  
   4.2 Hardware diagnostics ............................................................................................................... 7  
   4.3 Diagnostics for program blocks ................................................................................................. 8  
5. Task ................................................................................................................................................. 9  
6. Planning ........................................................................................................................................... 9  
   6.1 Online interface ........................................................................................................................... 9  
7. Structured step-by-step instructions ................................................................................................ 10  
   7.1 Retrieve an existing project ....................................................................................................... 10  
   7.2 Download the program ............................................................................................................. 11  
   7.3 Connect online ....................................................................................................................... 13  
   7.4 Online & diagnostics for SIMATIC S7 controller ...................................................................... 17  
   7.5 Online/offline comparison ....................................................................................................... 25  
   7.6 Monitor and modify tags .......................................................................................................... 28  
   7.7 Force tags .............................................................................................................................. 31  
   7.8 Checklist ................................................................................................................................. 35  
8. Exercise ......................................................................................................................................... 36  
   8.1 Task – Exercise ...................................................................................................................... 36  
   8.2 Planning ..................................................................................................................................... 36  
   8.3 Checklist – Exercise ............................................................................................................... 36  
9. Additional information ..................................................................................................................... 37
Basics of Diagnostic Functions

1 Goal

In this module, the reader will become acquainted with the tools that support troubleshooting.

This module will present diagnostic functions that, for example, you can test with the TIA project from the SCE_EN_031-100_FC-Programming with SIMATIC S7-1200 module.

The SIMATIC S7 controllers listed in Chapter 3 can be used.

2 Prerequisite

This chapter builds on the hardware configuration of SIMATIC S7 CPU1214C. However, other hardware configurations that have digital input and output boards can be used. For this chapter, you can use the following project, for example:

SCE_EN_031_100_FC-Programming_S7-1200_R1504.zap14
3 Required hardware and software

1 Engineering station: requirements include hardware and operating system (for additional information, see Readme on the TIA Portal Installation DVDs)

2 SIMATIC STEP 7 Basic software in TIA Portal – as of V14 SP1

3 SIMATIC S7-1200 controller, e.g. CPU 1214C DC/DC/DC with ANALOG OUTPUT SB1232 signal board, 1 AO – Firmware as of V4.2.1

Note: The digital inputs should be fed out to a control panel.

4 Ethernet connection between engineering station and controller
4 Theory

4.1 Fault diagnostics and hardware faults

Faults can be caused by a variety of things.

For faults that occur after a changeover to RUN, there are two error patterns.

1. The CPU goes to or stays in the STOP operating state. The yellow STOP LED lights up and other indicator LEDs light up on the CPU, power supply unit, IO modules or bus modules.

   A CPU fault is present in this case. For example, a module in the automation system might be defective or have an incorrect parameter assignment or a bus system fault might be present.

   An interruption analysis will be performed in this case by evaluating the hardware diagnostics and by reading the module information from the diagnostic buffer of the CPU.

2. The CPU is in a faulty RUN operating state. The green RUN LED lights up and other indicator LEDs light up or flash on the CPU, power supply unit, IO modules or bus modules.

   In this case, a fault may be present in the IO devices or power supply.
   
   A visual check will be performed initially to narrow down the fault area. The indicator LEDs on the CPU and IO devices will be evaluated. The diagnostic data of the faulty IO and bus modules will be read from the hardware diagnostics. In addition, a fault analysis can be performed using a watch table on the programming device.
4.2 Hardware diagnostics

The device view in online mode of the TIA Portal gives you a quick overview of the configuration and system status of the automation system.

Figure 1: Online view of device configuration
4.3 Diagnostics for program blocks

The project tree window of the TIA Portal in online mode gives you an overview of the programmed blocks of the user program. A comparison of the program blocks used offline and online is displayed with the help of diagnostic symbols.

Figure 2: Online view of the Main [OB1] block
5 Task

The following diagnostic functions will be shown and tested in this chapter:
- Diagnostic symbols in the online view of the TIA Portal
- Device diagnostics with module information
- Offline/online comparison
- Monitoring and modifying tags
- Forcing tags

6 Planning

The diagnostic functions will be performed using a finished project as an example. A project in the TIA Portal that was previously downloaded to the controller should be open for this.

In our case, once you have opened the TIA Portal, you will retrieve a previously created project that was archived and download it to the associated controller.

You can then start implementing the diagnostic functions in the TIA Portal.

6.1 Online interface

Online diagnostics can only be performed when the correct communication connection to the CPU has been established. We connect via Ethernet/PROFINET in this case.

When going online, you must therefore set the appropriate interfaces for your automation system.

![Connecting online](image-url)
7 Structured step-by-step instructions

You will find instructions on how to carry out planning below. If you already have a good understanding of everything, it will be sufficient to focus on the numbered steps. Otherwise, simply follow the detailed steps in the instructions.

7.1 Retrieve an existing project

→ Before we can start the diagnostic functions, we need a project with programming and a hardware configuration (e.g., SCE_EN_031-100_FC-Programming_S7-1200....zap14). To retrieve an existing project that has been archived, you must select the relevant archive with → Project → Retrieve in the project view. Confirm your selection with "Open".

(→ Project → Retrieve → Select a .zap archive → Open)

→ The next step is to select the target directory where the retrieved project will be stored. Confirm your selection with "OK". (→ Target directory → OK)
7.2 Download the program

→ After the project has been successfully retrieved, the controller can be selected and downloaded together with the created program. (→ ![Image])
→ Select the correct interfaces and click "Start search". (→ "PN/IE" → Selection of the network adapter of the PG/PC → Direct at slot '1 X1' → "Start search")

Once "Scan and information retrieval completed" appears, click "Load". (→ "Load")

→ Before downloading can be started, other actions may have to be set (pink marking). Then click "Load" again. (→ "Load").
After loading, first select the "Start all" check box under Action. Then click "Finish".

7.3 Connect online

To get started with the diagnostic functions, we will select our controller ("CPU_1214C") and click "Go online".
Once the online connection to the "PLC_1" controller is established, the CPU can be started or stopped with the following buttons. Diagnostic information in the form of symbols will already be available in the project tree and in the diagnostics window.

Symbols for the comparison status in the project tree

The diagnostic symbols in the project tree show a comparison status representing the online/offline comparison of the project structure.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="folder.png" alt="Folder" /></td>
<td>Folder contains objects with online and offline versions that differ (only in the project tree)</td>
</tr>
<tr>
<td><img src="online_offline.png" alt="Online/Offline" /></td>
<td>Online and offline versions of the object are different</td>
</tr>
<tr>
<td><img src="online.png" alt="Online" /></td>
<td>Object only exists online</td>
</tr>
<tr>
<td><img src="offline.png" alt="Offline" /></td>
<td>Object only exists offline</td>
</tr>
<tr>
<td><img src="same.png" alt="Same" /></td>
<td>Online and offline versions of the object are the same</td>
</tr>
</tbody>
</table>
→ Double-click the "Device configuration".

(→ Device configuration)

Operating state symbols for CPUs and CPs

→ The graphical representation and device information window show the various operating states of the CPU or communication processors (CPs).

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Operating state</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑️</td>
<td>RUN</td>
</tr>
<tr>
<td>☑️</td>
<td>STOP</td>
</tr>
<tr>
<td>☑️</td>
<td>STARTUP</td>
</tr>
<tr>
<td>☑️</td>
<td>HOLD</td>
</tr>
<tr>
<td>☑️</td>
<td>DEFECT</td>
</tr>
<tr>
<td>☑️</td>
<td>Unknown operating state</td>
</tr>
<tr>
<td>☑️</td>
<td>The configured module does not support display of the operating state.</td>
</tr>
</tbody>
</table>
Diagnostic symbols for modules and devices in the device overview

The graphical representation and Device overview window show the operating states of the various modules, CPU or communication processors (CPs) using the following symbols.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Connection" /></td>
<td>The connection to a CPU is currently being established.</td>
</tr>
<tr>
<td><img src="image" alt="CPU access" /></td>
<td>The CPU is not accessible at the configured address.</td>
</tr>
<tr>
<td><img src="image" alt="CPU type" /></td>
<td>The type of CPU configured and type of CPU actually present are incompatible.</td>
</tr>
<tr>
<td><img src="image" alt="Password entry" /></td>
<td>On establishment of the online connection to a protected CPU, the password dialog was terminated without entry of the correct password.</td>
</tr>
<tr>
<td><img src="image" alt="No fault" /></td>
<td>No fault</td>
</tr>
<tr>
<td><img src="image" alt="Maintenance" /></td>
<td>Maintenance required</td>
</tr>
<tr>
<td><img src="image" alt="Maintenance demanded" /></td>
<td>Maintenance demanded</td>
</tr>
<tr>
<td><img src="image" alt="Fault" /></td>
<td>Fault</td>
</tr>
<tr>
<td><img src="image" alt="Deactivation" /></td>
<td>The module or device is deactivated.</td>
</tr>
<tr>
<td><img src="image" alt="Access error" /></td>
<td>The module or device cannot be accessed from the CPU (valid for modules and devices below a CPU).</td>
</tr>
<tr>
<td><img src="image" alt="Diagnostic data" /></td>
<td>Diagnostic data is not available because the current online configuration data differs from the offline configuration data.</td>
</tr>
<tr>
<td><img src="image" alt="Configuration error" /></td>
<td>The configured module or device and the module or device actually present are incompatible (valid for modules or devices below a CPU).</td>
</tr>
<tr>
<td><img src="image" alt="Display error" /></td>
<td>The configured module does not support display of the diagnostic status (valid for modules below a CPU).</td>
</tr>
<tr>
<td><img src="image" alt="Connection established" /></td>
<td>The connection has been established, but the state of the module is currently still being determined.</td>
</tr>
<tr>
<td><img src="image" alt="Diagnosis error" /></td>
<td>The configured module does not support display of the diagnostic status.</td>
</tr>
<tr>
<td><img src="image" alt="Error lower level" /></td>
<td>Error in lower-level component: A fault is present in at least one lower-level hardware component.</td>
</tr>
</tbody>
</table>

Color coding of ports and Ethernet cables

The status of ports and Ethernet cables can be diagnosed in the network view and topology view.

The following table shows the possible colors and their respective meaning.

<table>
<thead>
<tr>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Green" /></td>
<td>No fault or maintenance required</td>
</tr>
<tr>
<td><img src="image" alt="Yellow" /></td>
<td>Maintenance demanded</td>
</tr>
<tr>
<td><img src="image" alt="Red" /></td>
<td>Communication error</td>
</tr>
</tbody>
</table>
7.4 **Online & diagnostics for SIMATIC S7 controller**

→ Double-click "Online & diagnostics" in project tree. (→ Online&Diagnosics)

→ A CPU operating panel, the cycle time and the memory utilization are displayed in the online tools at the right. Switch the CPU to RUN here. (→ RUN)
→ The working area window contains general information about the CPU. (→ General)

→ If diagnostic information is available, it is displayed in Diagnostic status. (→ Diagnostic status)
→ Detailed Information on the individual events is displayed in Diagnostics buffer. (→ Diagnostics buffer)

→ Next you receive information about the cycle time of the executed program. (→ Cycle time)
→ The memory utilization can be seen here in detail (→ Memory)

→ The network settings and the status of the PROFINET interface [X1] can also be displayed.
   (→ PROFINET interface [X1])
→ Under Functions, "Assign IP address", you can assign the IP address to a controller. However, this is only possible when no hardware has yet been downloaded to the CPU. (→ Functions → Assign IP address)

→ Under "Set time", you can set the time of the CPU. (→ Functions → Set time)
Under "Firmware update", you can update the firmware of the PLC.

(Functions → Firmware update)
→ Under "Assign name", you can assign a PROFINET device name to the configured field devices on PROFINET. The device name of the CPU cannot be changed here. It can only be changed by downloading a modified hardware configuration.

(→ Functions → Assign name)

→ Under "Reset to factory settings", you can restore the factory settings of the CPU.
(→ Functions → Reset to factory settings → Retain or delete IP address → Reset)
→ Under "Format memory card", you can format the optional memory card if it is inserted in the CPU. (→ Functions → Format memory card → Format)

→ The online connection should be disconnected again before the next chapter. (→ Online access → Go offline)

→ The TIA Portal is now back in offline mode. The orange-colored bars and the diagnostic symbols are no longer displayed.
### 7.5 Online/offline comparison

→ It is often important to know whether the saved data matches the data loaded in the controller. First, remove the negation from the "Safety_shutoff_active" tag at the AND function in the "MOTOR_MANUAL [FC1]" block.

Then save the "MOTOR_MANUAL [FC1]" block, but do **NOT** download it to the controller. Close the "MOTOR_MANUAL [FC1]" block again.

→ To compare, right-click the "PLC_1" controller and select "Compare", "Offline/online".

   (→ Select controller → Compare → Offline/online)

→ The Compare editor online opens.
→ If, for example, block differences are indicated 🎨, first select the block involved. You can then click the 🔍 button to "Start detailed comparison".

(→ MOTOR_MANUAL → Start detailed comparison).

→ The selected offline/online block will be compared in the code block comparison. A detailed description of the difference is shown in the comparison result.

→ Close the window of the code block comparison.
An action can be selected for the block involved in the Compare editor. Either the "MOTOR_MANUAL" block will be downloaded from the programming device to the controller and overwritten there or the "MOTOR_MANUAL" block will be read in from the controller and overwritten in the TIA Portal. Select the "Upload from device" action.

Click the "Execute actions" button.

Confirm "Upload from device".

After the upload, there are no more differences. You should now save your project again and close the online connection.
7.6 Monitor and modify tags

To monitor and modify tags, you need a watch table.

Double-click "Add new watch table" in the project tree. (→ Add new watch table).

Open the newly created "Watch table_1" by double-clicking it (→ "Watch table_1").

You can enter individual tags in the table or you can select the "Tag_table_sorting_station" and then select the tags to be monitored and drag them from the Details view to the watch table (→ Tag_table_sorting_station).
To have all monitoring and modifying functions available for selection, the following columns can be displayed:

‘All modify columns’ and ‘All expanded mode columns’

Continue by selecting the trigger timing for the monitoring (→ Permanent).

The following monitoring and modifying modes are available:

- Permanent (in this mode, the inputs are monitored/modified at the start of the cycle and the outputs at the end.)
- Once only, at start of scan cycle
- Once only, at end of scan cycle
- Permanently, at start of scan cycle
- Permanently, at end of scan cycle
- Once only, at transition to STOP
- Permanently, at transition to STOP
→ Next, click "Monitor all values once and now" or "Monitor all values according to trigger settings" (→ Monitor all).

→ To modify tags, enter the desired "Modify values". Then, click to "Modify all activated values once and now" or to "All active values will be modified by modify with trigger".

(→ TRUE to "All active values will be modified by modify with trigger")

→ Confirm the warning with 'Yes' (→ Yes).

→ The output becomes active even though the programmed conditions are not met.

**Note:** If the watch table is closed or the connection to the PLC is lost, all modify commands are nullified.
7.7 **Force tags**

The "Force" function can be used to assign a fixed value to tags. Force values are specified in a similar way as for the "Modify tags" function but, in contrast, are retained after the CPU is switched off or stopped. The "Modify tags" and "Force" functions essentially differ as follows:

- In contrast to "Modify tags", it is not possible to assign values to data blocks, timers, counters and bit memory with the "Force" function.

- IO device inputs (e.g., IWxx:P) cannot be modified but can be pre-assigned by the "Force" function.

- Unlike with the "Modify" function, values permanently assigned by the "Force" function cannot be overwritten by the user program.

- If you close the force table, the force values are retained. This is not the case with the "Modify" function.

- If the online connection to the CPU is interrupted, the tags assigned with the "Force" function retain their value.

To force tags, you must first double-click the force table to open it. (→ Force table)
→ Select the "Q1" operand with address %Q0.0 from the list. (→ Q1)

→ With forcing, the operands are entered with direct IO access (%Q0.0:P).

→ Enter the desired force value and activate it.

Click "Start or replace forcing". The new force request will be transferred to the CPU.

(→ %Q0.0:P → TRUE → Start or replace forcing)

→ Confirm the warning with 'Yes' (→ Yes).
→ Forcing is activated and the yellow **MAINT LED** on the CPU lights up. In addition, an **F** on a red background is shown at the top right of the display of the S7-1200.

![Image 1](image1.png)

**Note:** If the watch table is closed or the connection to the PLC is lost, **forcing remains active** and the yellow **FORCE LED** on the CPU continues to be lit.

→ If you want to ‘**Stop forcing**’, simply click **Stop forcing** and confirm the next dialog with "Yes".

(→ **Stop forcing** ‘Yes’ (→ Yes)

![Image 2](image2.png)

Forcing is stopped and the yellow **MAINT LED** on the CPU switches off.

→ If a force request already exists in the controller, this is indicated by the **F** symbol in the watch table. If you then click **F**, additional information will be displayed (→ **F**).

![Image 3](image3.png)
→ If a force request already exists in the controller, it can also be displayed and stopped via the online device view. To do this, you must right-click the CPU in online mode of the device view and select "Update and display forced operands".

   (→ right-click the CPU → Update and display forced operands)

→ The force table with the current force requests will now be displayed and you can stop these.

   (→ Stop forcing)
### 7.8 Checklist

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Project 031-100_FC-programming... successfully retrieved.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU 1214C from project 031-100_FC-Programming... successfully downloaded.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>CPU 1214C connected online.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Status of the CPU 1214C checked with Online &amp; Diagnostics.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Offline/online comparison of blocks in the CPU 1214C performed.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Watch table_1 created.</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Switch on conveyor motor forward by modifying the output (-Q1 = 1) in watch table.</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Switch off conveyor motor forward by modifying the output (-Q1 = 0) in watch table.</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Open force table</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Tag (-Q1:P) entered in force table.</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Switch on conveyor motor forward by forcing the output (-Q1 = 1) in force table.</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Force output -Q1 to switch off again.</td>
<td></td>
</tr>
</tbody>
</table>
8 Exercise

8.1 Task – Exercise

In this exercise, the MOTOR_AUTO [FB1] function block from chapter SCE_EN_031-200_FB-Programming is to be tested.

The challenge here is that the cylinder is in the front end position and thus the enable conditions for switching on the conveyor are not met.

Using a watch table, the cylinder is to be moved to its rear end position so that the enable conditions for the MOTOR_AUTO [FB1] block are met.

8.2 Planning

Plan the implementation of the task independently using the step-by-instructions as an aid.

8.3 Checklist – Exercise

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Project 031-200_FB-Programming… successfully retrieved.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU 1214C from project 031-200_FB-Programming… successfully downloaded.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Watch table created and renamed as &quot;Watch_table_cylinder&quot;.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Retract cylinder by modifying the output (-M2 = 1) in watch table.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Cylinder retracted (-B1 = 1)</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Reset output for Retract cylinder in watch table again (–M2 = 0).</td>
<td></td>
</tr>
</tbody>
</table>
9 Additional information

More information for further practice and consolidation is available as orientation, for example: Getting Started, videos, tutorials, apps, manuals, programming guidelines and trial software / firmware, under the following link:

www.siemens.com/sce/s7-1200

Preview „Additional information“

- Getting Started, Videos, Tutorials, Apps, Manuals, Trial-SW/Firmware
  - TIA Portal Videos
  - TIA Portal Tutorial Center
  - Getting Started
  - Programming Guideline
  - Easy Entry in SIMATIC S7-1200
  - Download Trial Software/Firmware
  - Technical Documentation SIMATIC Controller
  - Industry Online Support App
  - TIA Portal, SIMATIC S7-1200/1500 Overview
  - TIA Portal Website
  - SIMATIC S7-1200 Website
  - SIMATIC S7-1500 Website
Further Information

Siemens Automation Cooperates with Education
siemens.com/sce

SCE Learn-/Training Documents
siemens.com/sce/documents

SCE Trainer Packages
siemens.com/sce/tp

SCE Contact Partners
siemens.com/sce/contact

Digital Enterprise
siemens.com/digital-enterprise

Industrie 4.0
siemens.com/future-of-manufacturing

Totally Integrated Automation (TIA)
siemens.com/tia

TIA Portal
siemens.com/tia-portal

SIMATIC Controller
siemens.com/controller

SIMATIC Technical Documentation
siemens.com/simatic-docu

Industry Online Support
support.industry.siemens.com

Product catalogue and online ordering system Industry Mall
mall.industry.siemens.com

Siemens AG
Digital Factory
P.O. Box 4848
90026 Nuremberg
Germany

Subject to change and errors
© Siemens AG 2018